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1. About This Manual 

The Landisc™ Text Image Viewer User’s Manual is a simplified guide to the operation of the document-viewing component of a typical Enterprise Landisc database. It is intended for use by City, County, or Municipal employees who simply need to know how to view stored digital images of scanned documents, without going into great detail about the other more involved aspects of the Enterprise Landisc system, such as loading new images or replacing previously stored images.

Conventions

Whenever you see the term “click” used in this manual, it refers to clicking on an object with the LEFT mouse button of a standard 2-button mouse configured for a right-handed user.   

When it is intended for the user to click on an object with the RIGHT mouse button, the term “right-click” will be used. 

Boldfaced italicized text, which appears in all caps and enclosed within square brackets, is intended to signify that you should press one of the keys on a standard IBM-type keyboard that is imprinted with that same letter, word or symbol. 

EXAMPLES:  

                      [ENTER]  means you should press the “Enter” key. 
                      [ESC]      means you should press the “Escape” key. 

Many of the commands in this application have keyboard “accelerators” available.  Accelerators are a combination of the [Alt] key and a designated letter key, which are pressed simultaneously to open a drop-down menu.  The user may then execute a command from the menu by pressing the associated letter, in lieu of using the mouse.  Alternatively, the arrow keys may be used to highlight the desired command and then [ENTER] is pressed to execute the command. Accelerators are also sometimes referred to as keyboard “shortcuts,” but this nomenclature can be confusing since most users already refer to the Windows desktop icons as “shortcuts.” If an Accelerator or keyboard “shortcut” is available for a particular menu item, the first time that command is explained the key combination for the Accelerator it will be shown in boldface type enclosed in French brackets, i.e. {Alt-P}.   A complete chart of these Accelerators appears on the back side of the Quick Start Guide for the user’s convenience.

Note: The sample windows illustrated in this manual may appear slightly different depending on the operating system installed on your computer.

Copyright© 2002 by Cole-Layer-Trumble Co. All rights reserved.  No part of this document shall be reproduced, stored in a retrieval system, or transmitted by any means electronic, photographic, photostatic, recording or otherwise without prior written permission from the publisher.  No patent liability is assumed with respect to the use of the information contained herein.  Although every precaution has been taken in the preparation of this manual, the author and publisher assume no responsibility for errors or omissions.  Neither is any liability assumed for damages resulting from the use of the information contained herein. 
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Quick Start Guide
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1) Locate the Landisc Text Image Viewer shortcut icon on your desktop.

2) Click the icon to start the Landisc Text Image Viewer application.

3) Click the SEARCH button, the first button located on the graphic toolbar. 
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Search Button
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4) Type the Primary Identifier for the desired parcel into the Search area 
     of the Search Window.
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5)  Click the SELECT button.

6)  Click the VIEW DOCUMENT button to display document.
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                                                             \____________/
7)  Select the desired Document Type label from the drop-down list, if multiple 
     documents are available for the current record. 

Keyboard Accelerators

	                   
	MENU ITEM
	SUB-MENU ITEM
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 F – File 
	O – Open New Document

S – Printer Setup

P – Print Document

O – Options

X – eXit
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S – Search
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I – Select Default Index

S – Search
	P – Primary

S – Secondary

A – Account

I – Image Tag

J – Jurisdiction

	[image: image35.jpg]


V – View
	D – Document Details

T – Turn ON (OFF) Buttons
	

	H – Help
	I – Index

E – Email Tech Support

L – Landisc Home Page

A – About Text Image Viewer
	


2. Overview

The Landisc Text Image Viewer is the program module of the Enterprise Landisc System that is typically used to view electronically stored scanned documents.  Documents may either be scanned directly into the application from any standard TWAIN scanner, or they may be imported as a file.  Stored documents may also be exported for use with other applications.

Documents may be viewed one at a time by a single user, or by many users simultaneously, utilizing multiple computers connected in a network configuration. (Note: Multi-user licensing must be obtained from CLT Co. before the Landisc Text Image Viewer can be used on multiple computers.)

The advantages to scanning and storing documents electronically are many.  It helps minimize the number of actual paper documents that must be stored.  It provides increased security and more efficient use of office space.  Most importantly, it facilitates rapid, easy access to the information the documents contain without fear of damaging or degrading paper documents, which can become brittle and delicate over time.

The Text Image Viewer application also features powerful yet easy-to-use tools for zooming in, or magnifying a document.  Since the types of documents that are likely to be stored typically contain very small print and fine details, this can be very helpful to some users.

Stored document images are displayed along with identifying text, such as the parcel ID or map number of the corresponding parcel record or a secondary identification “string,” such as a routing number.  Routing numbers are unique identifiers that are assigned to the various properties by an appraisal team during the initial data and image gathering process.  

In addition to this identifying data, the Text Image Viewer features a user-definable Document Type label that is displayed at the top of the viewing window.  Since the Enterprise Landisc system is capable of storing a large number of documents for each parcel record, the Document Type label assists users in identifying multiple documents.

Documents may simply be viewed sequentially, from the first image stored to the last, or they may be selected at random.  Documents may be located by either entering the “key” identifying information for a parcel, or by searching an ordered list of parcel identifiers for the desired property record.  Users may navigate through the parcel records and access the available features by using standard drop-down menus; or by clicking on simplified graphic tool buttons.

3. Text Image Viewer Main Window

For the purpose of this discussion, it is assumed that the reader has access to a computer on which a working copy of Landisc Text Image Viewer has been properly installed. The user should also have one or more document images previously stored within the Landisc database by the Landisc System Administrator.  

Assuming these conditions have been met, locate the desktop shortcut icon for the Landisc Text Image Viewer.  The icon has a royal-blue colored background with an image of a satellite dish and a sheet of paper with a capital “A” on it, as shown in the sample below.  The letter “A” on the sheet of paper is a visual aid intended to help the user identify the Text Image Viewer as a tool intended for working with Text Documents, since all of the Landisc icons are quite similar.


Figure  AUTONUM  Landisc Text Image Viewer shortcut Icon  
Click on the icon. This will start the Landisc Text Image Viewer and a window like the one shown below should appear on your screen.   (Note: Your background colors may vary.)

Figure  AUTONUM  Landisc Text Image Viewer Main Window 

Refer to the illustration on the previous page, and those shown below, as we explore the main window of the Landisc Text Image Viewer.  The title bar tells us we are looking at an image of a home situated in the most well-known city in the entire world of property appraisal – Newtown, USA.  



Figure  AUTONUM  Project Name Display

Actually, Newtown is a fictional “project” that is built in to every Enterprise Landisc installation. This will provide a venue for training and experimentation with the Enterprise Landisc program without jeopardizing any of your actual data or images.  

You may do whatever you like to any of the elements within the Newtown Project without affecting any data or images stored within your actual working project database.  It is suggested that your Enterprise Landisc System Administrator set the Enterprise Landisc project to “Newtown” for the purpose of training new users of the system.

Three buttons common to all Microsoft® Windows® programs: Minimize, Restore, and Close are located in the title bar.   (Note: If you are not familiar with the function of these three buttons – then it is suggested that you STOP reading this manual now, and secure some training in the proper usage of the Microsoft Windows operating system before proceeding any further.)

Using the Menu Bar

Beneath the title bar is the “Menu Bar” (see illustration below) with the following elements: File, Search, View, and Help. Click on each one and examine the contents as we go through them one at a time.

   

        Menu Bar

Figure  AUTONUM  Menu Bar Display

4. The File Menu

Clicking on the FILE menu {Alt-F} will open a drop-down list with the following elements: OPEN NEW DOCUMENT, PRINTER SETUP, PRINT DOCUMENT, OPTIONS, and eXit.  

OPEN  

If we click on the first item, OPEN NEW DOCUMENT – an explorer window will open like the one shown below.
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Figure  AUTONUM  Standard Explorer Window

This is a standard Explorer® window, which allows you to point out the path to any document image file stored on your computer (or on any other networked storage device available to you). These stored images can be opened for display within the main Landisc Text Image Viewer display window.  The Explorer window is a standard feature of the Windows operating system, and we will not go into great detail with it, since the user is very likely to be familiar with it already. 

This feature would normally not be used to view images stored within your project database. Stored images are opened automatically by selecting a parcel identifier or by using one of the buttons on the toolbar.  

Printer Setup

If we click on FILE and then click the second item, PRINTER SETUP – a window will open like the one shown below.
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Figure  AUTONUM  Printer Setup Window

By clicking the appropriate radio buttons, the PRINTER SETUP window allows the user to select either the default Windows printer, or a specific printer selected from a drop-down list.  The user may also choose between Portrait (long dimension vertical) or Landscape (long dimension horizontal) paper orientation, as well as designating which source tray and paper size the printer should use. Below you will find a short description of the buttons located on the Printer Setup screen.
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	Clicking the OPTIONS button at the right side of the window will bring up the “Advanced Options” screen for the designated printer.
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	Clicking the OK button will execute any changes you have indicated and return you to the Landisc Text Image Viewer main screen.
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	Clicking the CANCEL button will simply return you to the Landisc Text Image Viewer main screen without making any changes to the printer setup.


Print Document

If we click on FILE and then click the third item, PRINT DOCUMENT, the document currently displayed in the Text Image Viewer Main Window will be sent to the default Windows printer.

Options

If we click on FILE and then click the fourth item, OPTIONS, a window like the one shown below will appear.


Exit

Create

New

Project

Radio

Buttons


Figure  AUTONUM  Options Window

This window allows the user to specify whether or not the Document Buttons are displayed along the top edge of the Text Image Viewer Main Window.  This feature is turned on and off by selecting the appropriate radio button as shown in the illustration above.  Refer to the two illustrations below for an example of how this feature looks when enabled or disabled.  This option controls the “DEFAULT” behavior of the program, which means that you will not see the results of any changes you make to this setting until you close and re-start the application


Figure  AUTONUM Graphic Tool Buttons Enabled


Figure  AUTONUM  Graphic Tool Buttons Disabled

The only other controls on this window are the Exit button and the “Create New Project” button.  

If you click on the Exit button you will be returned to the Text Image Viewer Main Window.

Use of the “Create New Project” button requires previous setup work by the Landisc Administrator, and will not be discussed in this manual.

Exit

If we click on FILE and then click the last menu item - EXIT, the Landisc Text Image Viewer application will close.

The Search Menu

Clicking on the SEARCH menu {Alt-S} will open up a drop-down list with the following elements: SELECT DEFAULT INDEX and SEARCH.

Select Default Index

If we click on SEARCH and then move the mouse over the first option, SELECT DEFAULT INDEX, a secondary menu will appear with the following options: Primary, Secondary, Address, Image Tag, and Jurisdiction. Choosing one of these options by clicking on it will determine the order in which the records are sorted from the database.  This ultimately controls the order in which any documents stored with those records are made accessible for viewing when we click on the “Next Property” button.

Search

The SEARCH menu is used to locate a specific parcel or series of parcels by allowing you to enter some or all of the information needed to identify those parcels into a search “criteria” area.  If we click on SEARCH and then select SEARCH again from the second menu, a window will appear that looks like the one shown below. If we look at the title bar at the top of the window, we will see that it says “Search for Primary ID.”  
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Figure  AUTONUM  Search Window
This indicates that the identifying criteria that will be used for the search we are about to execute will be the property’s Primary ID (sometimes referred to as the “primary key”).  We can change the field that is used to sort the records by selecting one of the “Radio Buttons” labeled Primary, Secondary, Address, Image Tag and Jurisdiction. These buttons are located just above the list of data shown in the example above.  Try selecting each of the various search “keys” by clicking the corresponding radio button and watch what happens to the contents of the list as you select each one.

An interesting feature of the Enterprise Landisc search routine is something we will refer to as “progressive searching.”  Bring up the SEARCH window, and verify that the first radio button, labeled “Primary” is checked and then type the following characters into the slot labeled “Search:”     B0303045 

Notice that as we type in each new character, at certain points the highlighted entry in the list of Primary ID numbers jumps down to meet the next entry in the list that could be a possible match for the criteria we are entering.  If you keep an eye on the list as you type, you may find that before you actually finish typing in the entire set of characters for a given property, the parcel you seek has already become highlighted.  At that point, you may click on the SELECT button, or simply press [ENTER] and that parcel’s image will be displayed without your having to type in the property’s entire identification string.  

While you are typing in the identifier for a particular property, if at some point the parcel you seek is not yet highlighted, but you can see it somewhere in the list on your screen, you may simply move the highlight down the list with the Down-Arrow key until it reaches the desired property and then click the select button (or hit [ENTER]). You also have the option of clicking on any identifier in the list at any time to immediately display that parcel’s image.  Since property identifiers are typically quite lengthy and often difficult to remember, these features can be a real time saver and eliminate a lot of repetitive typing during lengthy sessions at the keyboard.

Another valuable feature of the Enterprise Landisc system is the fact that the SEARCH screen always retains the last Property ID searched for in the topmost position of the list whenever the search screen is subsequently accessed, until the program has been closed and restarted again.  This can save a lot of time when going through a list of Property identifiers that are sequential or almost sequential in nature, especially when working in large databases containing many images.

Clicking the CANCEL or pressing [ESC] will return you to the Landisc Text Image Viewer main screen without effecting any changes to the program operation.

5. The View Menu

If we click on the VIEW menu {Alt-V}, will open up a drop-down list with the following elements: DOCUMENT DETAILS and TURN ON (OFF) BUTTONS.


Figure  AUTONUM  File Details Window

This window lists several descriptive parameters for the document image which is currently being displayed in the Text Image Viewer display window.  

Type refers to the image file type, which is this case is TIFF.

Pages show how many pages are present for the current document.

Width shows how many pixels wide the image is.

Height shows how many pixels high the image is.

Colors indicates the color format of the document, in this case a 256 Shade Gray Scale.

File Size shows the number of bytes required to store the currently displayed image.

Clicking the OK button will return you to the main Landisc™ Text Image Viewer display window.  

TURN ON (OFF) BUTTONS  

This feature control is what is known as a “toggle.” Selecting it will turn the Graphic Tool buttons ON if they are OFF and vice-versa.  The function of this control is exactly the same as the “Document Buttons” setting at the FILE|OPTIONS screen, except that it causes the button to appear or disappear immediately, without having to re-start the application.

6. The Help Menu

Clicking on the HELP menu {Alt-H} will open up a drop-down list with the following elements: Index, eMail Tech Support, Landisc Home Page, and About Landisc Text Image Viewer.

Index

If we click Index from the HELP menu, the built-in on line help menu will open.  This is a standard Windows Help screen, which the average user should already be quite familiar with.  The Windows Help screen is actually an HTML application, like an Internet web page, with clickable links and the ability to go back and forth between pages, sort of like a miniature web browser.

Email Tech Support

If we click the second item on the HELP menu, eMail Tech Support, your computer’s default email program will open, automatically set up to begin a new message addressed to CLT Company’s Landisc Tech Support Department.  The message already contains one line of text denoting your installed version level of Landisc, and your computer’s current operating system.  

You need only add any relevant comments regarding whatever problems you are experiencing with the program’s performance; connect your computer to the Internet; and send the email message to CLT.

Landisc Home Page

If we click the third item on the HELP menu, Landisc Home Page, providing that an active connection to the Internet is currently available, your computer’s default web browser will open and take you to the Cole Layer Trumble Company web page. From there, you can access Landisc support, 

If your computer is not currently on line, and your default web browser is configured to automatically make a connection to the Internet when opened, your computer will first access the default connection to your Internet service provider, and then take you to the Landisc support page.  

If your default web browser is not configured to automatically make a connection to the Internet, you must first manually establish a connection to your Internet service provider, and then click on the Landisc Home Page item from the HELP menu.

About Landisc Text Image Viewer
If we click the final item on the HELP menu - About Landisc Text Image Viewer, a window will open containing the buttons shown below.

Clicking on the various buttons will bring up the associated information screens as described below. These screens are primarily intended to provide information that will assist CLT tech support personnel in determining the nature and cause of any problems you may be experiencing with the application.
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	Exit will exit the screen and return to the program. 
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	About Landisc – Displays program and contact information.   

	[image: image11.bmp]
	Program Info – Displays information about the version level of Landisc Text Image Viewer that is currently installed on your computer.
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	System Info – Displays information about your computer’s hardware configuration and Operating System.
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	Project Info – Displays information about the location of data relevant to the currently selected Landisc project.
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	Web Page – Starts your default web browser and take you to the Landisc support page.
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	Email Support – Opens your default email program and begin a message to CLT Tech Support for the Landisc Text Image Viewer application.


Using The Graphic Toolbar

Beneath the standard Windows drop-down Menu Bar is a line of graphic buttons called the “Graphic Toolbar.”  


Graphic
Tool Bar

Figure  AUTONUM  Graphic Toolbar

The first three buttons are identical in function to some of the Menu Bar items we discussed earlier.  Refer to the illustrations below as we discuss the function of the various buttons on the Toolbar.

	  [image: image16.bmp]
	SEARCH - This button, which has an image of a flashlight or “search” light on it, will open a search window to allow you to locate a specific parcel or series of parcels by entering some or all of the information needed to identify those parcels into a search “criteria” area.  Refer to the Menu Bar section on FILE | SEARCH for more information.

	 [image: image17.bmp]
	OPEN IMAGE – This button, which has an image of a partially-opened file folder on it, will open a standard Windows Explorer window. This will allow you to point out the path to any image file stored anywhere on your computer (or on any other networked storage device available to you) to be opened for display within the main Landisc Text Image Viewer display window.

	 [image: image18.bmp]
	PRINT IMAGE – This button, with a graphic image of a printer on it, will send the document image that is currently being displayed in the Text Image Viewer Main Window to the default printer.  For further details on the printing documents, see the previous Menu Bar section on FILE | PRINT.


The next group of buttons is used to step through the database of property images one at a time, forward or backward alphanumerically, depending on whichever identifying field has been selected as the Default Index.
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	FIRST RECORD – will access the first record in the current project database, sorted alphanumerically by the identifying field that has been selected as the Default Index.

	[image: image20.bmp]
	PREVIOUS RECORD – will access the record before the record that is currently being accessed from the project database, sorted alphanumerically by the identifying field that has been selected as the Default Index. 
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	NEXT RECORD – will display the next sequential record in the database, sorted alphanumerically by the identifying field that has been selected as the Default Index.

	[image: image22.bmp]
	LAST RECORD – will display the final record in the database, sorted alphanumerically by the identifying field that has been selected as the Default Index.


	
	VIEW DOCUMENT – This button will cause a document (or the first multiple document) associated with a record to be displayed within the Text Image Viewer main window.


Document Type Drop-Down List
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	Document Type list (closed view) – This feature allows the user to select a multiple document stored for a parcel record by choosing the desired label from a drop-down list.
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	Document Type List (open view) – Open the list by clicking the arrow as shown, and then select the desired document from the list of Document Types by clicking on it.


Zoom / Magnify Control Buttons

	
	ZOOM IN – This button will zoom in on the image in the Document Window in steps of 18% of the original image size per click.



	
	ZOOM OUT – This button will zoom out from the image in the Document Window in steps of 18% of the original image size per click.



	
	ZOOM TO SELECTION – When clicked, this button will allow you to select a rectangular area on the screen by clicking and dragging open a selection box, then zoom in until the selected perimeter fills the screen.

	
	FIT SCREEN – This button will zoom in or out, as needed, until the entire document image is visible at the same time within the currently defined borders of the Document Window.
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